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Revision History
The following table lists the revisions of this document.

Revision Change Description

Revision 01 Initial release.

Table 1: Revision History
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About this Guide

This guide describes the steps to install, configure, and deploy the Aruba Mobility Master or a Virtual Mobility
Controller (VMC) on:

l vSphere Hypervisor

l Kernel-Based Virtual Machine (KVM) Hypervisor

For information related to licensing, refer to the Aruba Mobility Master Licensing Guide.

Important
The following sections of the guide have references to configuration changes that need to be made when
installing a VMC:

l System Requirements

l Assigning Network Connections

Conventions
The following conventions are used throughout this document to emphasize important concepts:

Type Style Description

Italics This style is used to emphasize important terms and to mark the titles of books.

System

items

This fixed-width font depicts the following:

l Sample screen output

l System prompts

l Filenames, software devices, and specific commands when mentioned in the text

Commands In the command examples, this bold font depicts text that you must type exactly as
shown.

<Arguments> In the command examples, italicized text within angle brackets represents items that you
should replace with information appropriate to your specific situation. For example:
# send <text message>

In this example, you would type “send” at the system prompt exactly as shown, followed
by the text of the message you wish to send. Do not type the angle brackets.

[Optional] Command examples enclosed in brackets are optional. Do not type the brackets.

{Item A |

Item B}

In the command examples, items within curled braces and separated by a vertical bar
represent the available choices. Enter only one choice. Do not type the braces or bars.

Table 2: Typographical Conventions
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The following informational icons are used throughout this guide:

Indicates helpful suggestions, pertinent information, and important things to remember.

Indicates a risk of damage to your hardware or loss of data.

Indicates a risk of personal injury or death.



Contacting Support

Main Site arubanetworks.com

Support Site support.arubanetworks.com

Airheads Social Forums and
Knowledge Base

community.arubanetworks.com

North American Telephone 1-800-943-4526 (Toll Free)

1-408-754-1200

International Telephone arubanetworks.com/support-services/contact-support/

Software Licensing Site hpe.com/networking/support

End-of-life Information arubanetworks.com/support-services/end-of-life/

Security Incident Response Team Site: arubanetworks.com/support-services/security-
bulletins/

Email: sirt@arubanetworks.com

Table 3: Contact Information

http://www.arubanetworks.com/
https://support.arubanetworks.com/
http://community.arubanetworks.com/
http://www.arubanetworks.com/support-services/contact-support/
https://hpe.com/networking/support
http://www.arubanetworks.com/support-services/end-of-life/
http://www.arubanetworks.com/support-services/security-bulletins/
http://www.arubanetworks.com/support-services/security-bulletins/
mailto:sirt@arubanetworks.com
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Chapter 2
Introduction

The Aruba Mobility Master and VMC provide a 64-bit virtualized software-based managed platform on virtual
machine (VM) architecture. The Aruba Mobility Master and VMC operate on x86 platforms in a hypervisor
environment and can reside with other virtualized appliances. The Aruba Mobility Master and VMC are
centralized management platforms for deployment in a virtualized network infrastructure. Some of the key
security features offered by the Aruba Mobility Master and VMC are:

l Authentication

l Encryption Support

l Security Policy

l Rogue Detection and Suppression

l Security Firewall

Aruba does not recommend over subscription of processors, memory, and NIC ports on the virtual machine.

Listed below are few advantages of switching to Aruba Mobility Master or VMC environment:

l Reduces the number of devices occupying rack space and the overheads associated with managing and
servicing products from different vendors.

l Multiple services are consolidated on a common platform, thereby reducing the cost and optimizing the
infrastructure by providing consolidated services.

l Additional devices can be deployed remotely, increasing hardware selection option and flexibility.

l By eliminating a single point failure, you can create a reliable and high-performance networking system.

On successfully installing the Aruba Mobility Master/VMC, refer to the ArubaOS 8.0.x Quick Start Guide for steps
to setup the network.

What's New
This section lists the new features and enhancements released in this version of the Installation Guide.

Seamless Logon
The Seamless Logon feature enables you to login from the Mobility Master to a managed device without
entering a password. The user can remotely login from a centralized location (Mobility Master) to any managed
device and execute any show commands.

This feature is not available on the Virtual Mobility Controller.

System Requirements
Listed below are the minimum hypervisor host system requirements for ArubaOS to run as a guest VM and the
resources required for the VM to be functional:
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Host Requirements Aruba Mobility
Master Virtual Mobility Controller

Quad-core Core i5 1.9 GHz CPUs
(hyperthreading enabled)

8 4

Memory 16 GB 8 GB

Physical NIC ports

NOTE: One NIC port is shared with the
host management and the second is
reserved for datapath.

2 2

Disk space 64 GB 32 GB

Table 4: System Requirements

Aruba does not recommend over subscription of processors, memory, and NIC ports on the virtual machine.

ArubaOS VM Requirements
Listed below are the minimum resources required for the ArubaOS VM to function:

SKUs Hypervisor Total vCPU (hyper
threaded)

Memory
(GB) Flash/Disk (GB) Total Supported

Interfaces

MM-
VA-500

ESXi 6 8 8 2 data ports (0/0/0,
0/0/1), 1 mgmt port

MM-
VA-1K

ESXi 8 12 12 2 data ports (0/0/0,
0/0/1), 1 mgmt port

MM-
VA-5K

ESXi 10 16 16 2 data ports (0/0/0,
0/0/1), 1 mgmt port

MM-
VA-10K

ESXi 16 32 32 2 data ports (0/0/0,
0/0/1), 1 mgmt port

MM-
VA-500

KVM 6 8 8 2 data ports (0/0/0,
0/0/1), 1 mgmt port

MM-
VA-1K

KVM 8 12 12 2 data ports (0/0/0,
0/0/1), 1 mgmt port

MM-
VA-5K

KVM 10 16 16 2 data ports (0/0/0,
0/0/1), 1 mgmt port

MM-
VA-10K

KVM 16 32 32 2 data ports (0/0/0,
0/0/1), 1 mgmt port

Table 5: Memory and CPU Allocation - Virtual Mobility Master



SKUs Hypervisor Total vCPU (hyper
threaded)

Memory
(GB) Flash/Disk (GB) Total Supported

Interfaces

MC-VA-
32

ESXi 3 4 4 3 data ports (0/0/0,
0/0/1), 1 mgmt port

MC-VA-
50

ESXi 4 6 6 3 data ports (0/0/0,
0/0/1), 1 mgmt port

MC-VA-
250

ESXi 5 6 6 3 data ports (0/0/0,
0/0/1), 1 mgmt port

MC-VA-
1K

ESXi 6 8 8 3 data ports (0/0/0,
0/0/1), 1 mgmt port

MC-VA-
32

KVM 3 4 4 3 data ports (0/0/0,
0/0/1), 1 mgmt port

MC-VA-
50

KVM 4 6 6 3 data ports (0/0/0,
0/0/1), 1 mgmt port

MC-VA-
250

KVM 5 6 6 3 data ports (0/0/0,
0/0/1), 1 mgmt port

MC-VA-
1K

KVM 6 8 8 3 data ports (0/0/0,
0/0/1), 1 mgmt port

Table 6: Memory and CPU Allocation - Virtual Mobility Controller

The hypervisor host should not be oversubscribed in terms of number of VMs configured on a host as it
adversely impacts the functionality and performance of ArubaOS. In instances where more than one VM is
setup in a hypervisor, then:

l The number of logical processors reported on the hypervisor should be higher or equal to the sum of vCPUs
allocated to each of the VMs setup in that host.

l The sum of the memory allocated to each VM should not exceed the overall host memory capacity
reported.

l The total CPU utilization, memory usage, and network throughput should not exceed 80% of the host
capacity.

Aruba Mobility Master and VMC | Installation Guide Introduction |  11
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Chapter 3
Installing ArubaOS on vSphere Hypervisor

Prerequisites
Ensure that the following prerequisites are addressed before starting the installation:

l vSphere Client/vCenter 5.1 or 5.5 is installed on a Windows machine.

l vSphere Hypervisor 5.1 or 5.5 is installed on the server that hosts the Mobility Master/VMC as a guest.

l OVF template is obtained from an Aruba representative and accessible from vSphere Client/vCenter.

Logging Into ESXi Host Using vSphere Client
This section describes the configuration of the VM using the vSphere Windows client, if vCenter infrastructure is
available the same can be achieved through the web interface provided by vCenter.

Follow the steps to log in to the vSphere ESXi Host:

1. Open the vSphere Client.

2. Enter the IP address or name of the vSphere Hypervisor in the IP address / Name field.

3. Enter the user name in theUser name field.

4. Enter the password in the Password field.

5. Click Login.

The vSphere Client page is displayed.

Creating A VM Network For Management
Follow the steps below to create a VM network for management:

1. Log in to the vSphere ESXi Host using vSphere Client. For additional information, see Logging Into ESXi Host
Using vSphere Client.

2. From the vSphere Client page, click Inventory.
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Figure 1 Inventory Button

3. Click Configuration tab.

4. Click Networking from theHardware menu.

5. Click Add Networking.
TheAdd Network Wizard is displayed.

Figure 2 Adding A Network

6. Select theVirtual Machine option and click Next.
7. Select the vSwitch that has VMkernel port mapped for ESXi management network and click Next.



Figure 3 Selecting A Network Adapter For Management

8. In the Port Group Properties section, provide a name forNetwork Label and select All (4095) from the
VLAN ID (Optional) drop-down list. Click Next.

Figure 4 Selecting Port Group Properties

9. Click Finish.

The VM network name is set to VM Network_Management and is used as an example in all configuration procedures.

10.Click the ESXi host IP address.

11.Click theConfiguration tab.

12.Click Networking from theHardware section.

13.Click Properties of theVM Network_Management.

Aruba Mobility Master and VMC | Installation Guide Installing ArubaOS on vSphere Hypervisor |  14
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Figure 5 VMNetwork Properties_Management

14.Select the port that was created earlier and click Edit.

Figure 6 Edit Network Properties_Management

15.Select Promiscuous Mode and Forged Transmits check box and Accept from the drop-down list.

Forged Transmits should be enabled for VRRP to function.



Figure 7 Selecting VM Network Properties

16.Click OK.

17.Click Close.

Creating VM Networks For Traffic
Follow the steps below to create a VM network for traffic:

1. Repeat steps 1 to 4 of Creating A VM Network For Management.

2. Click Add Networking.
TheAdd Network Wizard is displayed.

Figure 8 Adding A Network For Traffic

3. Select theVirtual Machine option and click Next.
4. Select a vSwitch that will handle the network traffic and click Next.

Aruba Mobility Master and VMC | Installation Guide Installing ArubaOS on vSphere Hypervisor |  16
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Figure 9 Selecting A Network Adapter For Traffic

5. In the Port Group Properties section, provide a name forNetwork Label and select All (4095) from the
VLAN ID (Optional) drop-down list. Click Next.

Figure 10 Selecting Port Group Properties

6. Click Finish.

Ensure that the Management VM network and the Traffic VM network is isolated to avoid a network loop.

7. Click the ESXi host IP address.

8. Click theConfiguration tab.

9. Click Networking from theHardware section.

10.Click Properties of the vSwitch to edit.



Figure 11 VMNetwork Properties_Traffic

11.Select the port that was created earlier and click Edit

Figure 12 Edit Network Properties_Traffic

12.Select Promiscuous Mode and Forged Transmits check box and Accept from the drop-down list.

Aruba Mobility Master and VMC | Installation Guide Installing ArubaOS on vSphere Hypervisor |  18
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Forged Transmits should be enabled for VRRP to function.

13.Click OK.

14.Click Close.

Repeat the steps to enable Promiscuous mode on the other two networks.

Deploying the OVF Template
Follow the steps below to deploy the Open Virtual Format (OVF) template:

1. Log in to the vSphere ESXi Host using vSphere Client. For additional information, see Logging Into ESXi Host
Using vSphere Client.

2. Click File > Deploy OVF Template.

TheDeploy OVF Template Wizard is displayed.

It is recommended to copy the template to the client machine before importing the OVF template.

3. Click Browse and navigate to the location of the OVA file and click Next.
TheOVF Template Details option in the left pane is displayed.

4. Click Next.
TheName and Location option in the left pane is displayed.

5. In theName field, enter a name for the OVF template and click Next.
TheDisk Format option in the left pane is displayed.

6. Select Thick Provision Lazy Zeroed option and click Next.
TheNetwork Mapping option in the left pane is displayed.

7. Select VM Network_Management from the Network Label drop-down list and click Next.
TheReady to Complete option in the left pane is displayed.



Figure 13 Network Mapping

Review your preferences before clicking Finish.

Do not select Power on after deployment check box in the Ready to Complete window.

8. Click Finish.

The OVF template is deployed.

Since the deployment of the OVF template is time consuming, it is highly recommended that the client is on the same
VLAN as the Mobility Master/VMC.

9. Click OK.

10.Click Close.

Pre-Allocating Memory in Aruba Mobility Master/VMC
Follow the steps below to pre-allocate memory in Aruba Mobility Master/VMC:

1. Right-click the VM and select Edit Settings or click Edit virtual machine settings from theGetting
Started tab.

2. From theResources tab select Memory.
3. Select theReserve all guest memory (All locked) check box.

4. Click OK.

Aruba Mobility Master and VMC | Installation Guide Installing ArubaOS on vSphere Hypervisor |  20
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Figure 14 EditingMemory Settings

Repeat the steps to pre-allocate memory for other ArubaOS VMs.

For more information on memory and CPU allocation refer to sizing tables in ArubaOS VM Requirements on
page 10 section.

Assigning Network Connections
By default the management network is assigned to all network adapters. If different networks are not assigned
to different adapters it will result in a network loop.

Follow the steps below to assign different networks to different adapters:

1. Click Edit virtual machine settings.



Figure 15 Virtual Machine Settings

2. Select Network adapter2 and select VM Network_Traffic from theNetwork label drop-down list.

Figure 16 Assigning A Network

3. Repeat the steps and assign:

a. Network adapter3 to VM Network_Traffic1
b. Network adapter4 to VM Network_Traffic2

4. Click OK.

Aruba Mobility Master and VMC | Installation Guide Installing ArubaOS on vSphere Hypervisor |  22
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The Mobility Master does not support more than three network interfaces, but VMC supports four interfaces.

Enabling Security Profile Configuration
This is an optional step and should be used only if serial console redirection is required. To enable security
profile configuration you need to Telnet over the network.

1. Click the ESXi host IP address.

2. Click theConfiguration tab.
3. In the Software section, click Security Profile.

4. In the Firewall section, click Properties.

5. Scroll down to VM serial port connected over network and ensure that the check box is selected.

Figure 17 Enabling VM Serial Port Connected Over Network

6. Click OK.

Configuring Serial Console for the VM
Follow the steps below to configure serial console for the VM:

1. Click Edit virtual machine settings.



Figure 18 Edit Virtual Machine Settings

2. On theHardware tab, click Add.

3. Select Serial Port and click Next.
4. Select Connect via Network and click Next.

Figure 19 Configuring Serial Console

5. Select Server (VM Listens for connection) and enter telnet://:6001 in the Port URI field.

Aruba Mobility Master and VMC | Installation Guide Installing ArubaOS on vSphere Hypervisor |  24
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Figure 20 Connecting The Serial Via Network

6. Click Finish > OK.

If more than one virtual machine is present, ensure that it is not connected to the same port.
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Chapter 4
Installing ArubaOS on a KVM Hypervisor

Prerequisites
Ensure that the following prerequisites are addressed before starting the installation:

l Enabling Intel VT virtualization hardware extensions in BIOS.

l Installing CentOS 7.2 on the x86 hardware.

Enabling Intel VT Virtualization Hardware Extensions in the BIOS
Follow the steps below to enable Intel IT virtualization hardware extensions in the BIOS:

1. Power on the machine and access theBIOS Settings.

2. Navigate to the Processor submenu. Processor settings menu may be hidden in Chipset,Advanced CPU
Configuration, orNorthbridge.

3. Enable Intel Virtualization Technology.

Installing CentOS 7.2
Follow the steps below to install CentOS 7.2 on your system:

1. Connect a DVD or bootable USB stick to install CentOS 7.2.

2. Select Virtualization Host in Software Selection and select allAdd-Ons for the installation.

3. Click Done.

4. Navigate to the location of the CentOS 7.2 file and select the destination folder.

5. Click Begin Installation.

6. Create a new user and a root password for the CentOS 7.2 installation during the installation process.

7. Reboot the server after the installation is complete.

8. Login to the newly installed CentOS 7.2 and configure the network and connect the server to the Internet.

A connection to the Internet is required to validate the installation and to install other packages.

a) Check for cpu virtualization support by executing the following command:

[root@localhost ~]# cat /proc/cpuinfo | grep -i vmx flags : ……..vmx ……..

b) Check for KVM mode support in the Kernel. If kvm_intel is not listed, manually load kvm_intel using the
modprobe kvm_intel command.

[root@localhost ~]# lsmod | grep -i kvm

kvm_intel 162153 0

kvm 525259 1 kvm_intel

[root@localhost ~]#

If the Operation not supported error message is displayed, ensure that Intel Virtualization technology is enabled in
the BIOS.

9. Install the following packages:

l yum install qemu-kvm-tools.x86_64 qemu-kvm.x86_64 qemu-kvm-common.x86_64
l yum install virt-manager.noarch virt-manager-common.noarch
l yum install virt-install.noarch
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l yum groupinstall "GNOME Desktop"
l yum install tigervnc-server xorg-x11-fonts-Type1

Follow the steps below to install the ArubaOS Mobility Master or a Virtual Mobility Controller (VMC) on a
KVM hypervisor:

1. Configuring the Virtual Network Computing (VNC) Server.

2. Creating a new VM and installing ArubaOS.

3. Deploying the Mobility Master/VMC.

Configuring the Virtual Network Computing Server
Follow the steps below to configure the Virtual Network Computing (VNC) server and open up the firewall port
to access the server remotely:

1. Start the VNC Server and configure a password for your CentOS server by executing the following
command:
[root@localhost ~]# vncserver.You will require a password to access your desktop.

Password:

Verify:

xauth: file /root/.Xauthority does not exist

New 'localhost.localdomain:1 (root)' desktop is localhost.localdomain:1

Creating default startup script /root/.vnc/xstartup

Starting applications specified in /root/.vnc/xstartup

Log file is /root/.vnc/localhost.localdomain:1.log

2. Open the firewall port on the CentOS server to ensure the CentOS server can be accessed using vncviewer.
[root@localhost ~]# netstat -ntap | grep vnc

tcp 0 0 0.0.0.0:5901 0.0.0.0:* LISTEN 14318/Xvnc

tcp 0 0 0.0.0.0:5902 0.0.0.0:* LISTEN 5242/Xvnc

tcp 0 0 10.16.9.130:5902 10.20.102.206:51576 ESTABLISHED 5242/Xvnc

tcp6 0 0 :::5901 :::* LISTEN 14318/Xvnc

tcp6 0 0 :::5902 :::* LISTEN 5242/Xvnc

[root@localhost ~]#

[root@localhost ~]# firewall-cmd --permanent --zone=public --add-port=5901/tcp

success

[root@localhost ~]# firewall-cmd --reload

success

[root@localhost ~]#

3. Download the AOS ISO image file from support.arubanetworks.com to your CentOS server. The
following are examples of ISO image files:

l ArubaOS_MM_8.0.1.0_57113.iso.

l ArubaOS_VMC_8.0.1.0_57113.iso.

Creating a VM and Installing ArubaOS
Follow the steps below to access the CentOS server through the VNC and start the virt manager to create the
VM to be used by ArubaOS:

1. Access the terminal and type virt-manager to start the Virtual Machine Manager.

2. Access theVirtual Machine Manager tab.

3. Click on File > New Virtual Machine. TheNew VM dialog box is displayed.



Figure 21 New Virtual Machine

4. Select Choose Local Install Media and click Forward.

5. Select Use ISO image and click Browse.

6. Navigate to the location of the iso image and click Choose Volume.

Ensure that Automatically detect operating system based in install media is not selected.

7. Select OS type as Linux and Version as Redhat Enterprise Linux 7.2 from the drop-down lists and click
Forward.

8. Change theMemory (RAM) to 8192 and CPUs to 6 and click Forward.

For VMC the RAM can be setup as 4096 (4GB) and 3 CPUs. For more information on memory and
CPU allocation refer to sizing tables in the ArubaOS VM Requirements on page 10 section.

9. Select Enable Storage for this VM and change the value in Create a disk image on the computer's
hard drive to 4 GB. Click Forward.

Aruba Mobility Master and VMC | Installation Guide Installing ArubaOS on a KVM Hypervisor |  28
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Figure 22 Enabling Storage on the VM

The size of this disk needs to be at least 4 GB for Mobility Master/VMC.

10.Provide a name for the VM and select Customize configuration before install. Click Finish.

Figure 23 Beginning the Installation

11.Select VirtIO Disk 1 and click on Advanced Options and make sure theDisk bus option is VirtIO.



12.Click Add Hardware and add another storage device of 8 GB size (should be greater than half the size of
RAM configured for the Mobility Master/VMC).

13.Select VirtIO from theBus type drop-down list. Click Finish.

Figure 24 Adding a Second Storage Device

Creating Bridge Entries
Create bridge entries to map all three network adapters that you will create in the steps below:

Ensure that you create a fourth bridge entry when configuring VMC.

1. Login to CentOS and create three bridges and map three physical interfaces to these bridges.
[root@localhost ~]# brctl addbr br1

[root@localhost ~]# brctl addif br1 eno1

[root@localhost ~]# ifconfig br1 up

[root@localhost ~]# brctl addbr br2

[root@localhost ~]# brctl addif br2 eno2

[root@localhost ~]# ifconfig br2 up

[root@localhost ~]# brctl addbr br3

[root@localhost ~]# brctl addif br3 eno3

[root@localhost ~]# ifconfig br3 up

2. To make these bridge entries persistent across reboots, create a file in /etc/sysconfig/network-scripts/
for all bridges.

Aruba Mobility Master and VMC | Installation Guide Installing ArubaOS on a KVM Hypervisor |  30
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[root@localhost ~]#vi /etc/sysconfig/network-scripts/ifcfg-br1

DEVICE=br1

STP=no

TYPE=Bridge

IPV6INIT=yes

IPV6_AUTOCONF=no

IPV6_DEFROUTE=yes

IPV6_FAILURE_FATAL=no

NAME=br1

UUID=a65be46d-a32a-4dca-bd00-f8acf9a356e5

ONBOOT=yes

IPV6_PRIVACY=no

[root@localhost ~]#

[root@localhost ~]# cat /etc/sysconfig/network-scripts/ifcfg-br2

DEVICE=br2

STP=no

TYPE=Bridge

IPV6INIT=yes

IPV6_AUTOCONF=no

IPV6_DEFROUTE=yes

IPV6_FAILURE_FATAL=no

NAME=br2

UUID=19cf4539-9633-40aa-a4c5-606849b6e3db

ONBOOT=yes

IPV6_PRIVACY=no

[root@localhost ~]#

[root@localhost ~]# cat /etc/sysconfig/network-scripts/ifcfg-br3

DEVICE=br3

STP=no

TYPE=Bridge

IPV6INIT=yes

IPV6_AUTOCONF=no

IPV6_DEFROUTE=yes

IPV6_FAILURE_FATAL=no

NAME=br3

UUID=cb9a8df9-aa37-4346-8993-9e3739a9b0ce

ONBOOT=yes

IPV6_PRIVACY=no

3. Click Network Interface and enter the following values:

l Network Source: Specify shared device name.

l Bridge name: br1

l Device model: virtio



Figure 25 Creating Bridge Entries

4. Click Add Hardware to add two more network interfaces.

5. Map bridge interfaces (br2 and br3) to these network interfaces.

6. Click Add Hardware to add serial console.

Enabling Serial Console Over Telnet
Follow the steps below to enable serial console over telnet. This procedure is optional.

1. Remove the existing Serial 1 device and click Add Hardware.

2. Select Serial on the left pane.

3. Select TCP net Console from theDevice Type drop-down list.

4. Add the CentOS Server IP in theHost field and change the port number.

5. Select theUse Telnet check box and click Finish.
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Figure 26 Enabling Serial Console Over Telnet

6. Execute the following command to ensure the host firewall permits access to port number for serial
console.
[root@localhost ~]# firewall-cmd --permanent --zone=public --add-port=4560/tcp

success

[root@localhost ~]# firewall-cmd --reload

success

Enable serial console redirection from the ArubaOS CLI after ArubaOS boots up by executing the following command
serial console redirection enable.

7. Select VNC server as the Spice Server from the Type drop-down list.

8. Select Copy local keymap from theKepymap drop-down list and click Apply.

9. Select CPUs and make select theCopy host CPU configuration option.

10.Select theManually set CPU topology option from the Topology drop down list.

11.Ensure the number of Sockets and Threads is always 1 and the value of Cores is the same as the value of
Current allocation.



Figure 27  Configuring CPU Values

12.Click Begin Installation and select Install ArubaOS.

Figure 28 Installation Screen

Once the installation is complete the system will be halted after configuring the Mobility Master/VMC.
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Figure 29 System Halt

13.Force reset the VM to boot ArubaOS and access to first boot dialogue.

Important

l Ensure you open the firewall port from CentOS terminal and restart the firewall.
[root@localhost ~]# firewall-cmd --permanent --zone=public --add-port=7001/tcp

success

[root@localhost ~]# firewall-cmd --reload

success

[root@localhost ~]#

Configure Multiple Datapath CPUs
To configure multiple datapath CPU’s additional configuration is required both in host and guest. The guest
changes cannot be made using virt-manager and hence you need to use the virsh edit command.

Ensure that the virtual machine is gracefully shut down by using either the Reboot or Shut Down option before
editing the VM xml specification.

Figure 30 Graceful Shutdown

Changes in Host
On the KVM server, load the vhost_net module
[root@localhost ~]# lsmod | grep vhost

[root@localhost ~]# modprobe vhost_net



[root@localhost ~]# lsmod | grep vhost

vhost_net 18152 0

vhost 33338 1 vhost_net

macvtap 22363 1 vhost_net

tun 27141 3 vhost_net

XML Changes in Guest
Use the virsh edit <name of the VM> command in the KVM server and add the <driver name='vhost'
queues='y'/>” tag, where y = total number of CPU’s allocated to the VM.

For example, for a VM with six VCPU’s and three NIC’s of type Virtio, edit the xml and add <driver
name=’vhost’ queues=’6’> “ tag for each NIC interface.
aruba@ubuntu-server-16x:~$ virsh list --all

Id Name State

----------------------------------------------------

5 centos6.5 running

- vmm-500dev shut off

[root@localhost ~]# virsh edit vmm-500dev

Domain vmm-500dev XML configuration edited.

Add <driver name='vhost' queues='6'/> after “model type=’virtio’” in the bridge config to ensure the
values for the number of queues for the vhost and CPUs for the VM are the same.

The following snippet is an example of multi-queue XML specification for a single NIC interface. The same tag
needs to be added for all Mobility Master NIC interfaces.
</controller>

<interface type='bridge'>

<mac address='52:54:00:d3:4a:3c'/>

<source bridge='br1'/>

<target dev='vnet10'/>

<model type='virtio'/>

<driver name='vhost' queues='6'/>

<alias name='net0'/>

<address type='pci' domain='0x0000' bus='0x00' slot='0x03' function='0x0'/>

</interface>

<interface type='bridge'>

<mac address='52:54:00:49:7a:c6'/>

<source bridge='br2'/>

<target dev='vnet11'/>

<model type='virtio'/>

<driver name='vhost' queues='6'/>

<alias name='net1'/>

<address type='pci' domain='0x0000' bus='0x00' slot='0x04' function='0x0'/>

</interface>

<interface type='bridge'>

<mac address='52:54:00:d3:55:7d'/>

<source bridge='br3'/>

<target dev='vnet12'/>

<model type='virtio'/>

<driver name='vhost' queues='6'/>

<alias name='net2'/>

<address type='pci' domain='0x0000' bus='0x00' slot='0x05' function='0x0'/>

</interface>

[root@localhost ~]# virsh edit vmm-500dev

Domain vmm-500dev XML configuration edited.
[root@localhost ~]# virsh dumpxml vmm-500dev | grep queues

<driver name='vhost' queues='6'/>

<driver name='vhost' queues='6'/>

<driver name='vhost' queues='6'/>
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[root@localhost ~]#

Reboot the VM and once the VM boots up you should see three CPUs as indicated in the example
(ArubaMM) [mynode] #show datapath utilization

Datapath Network Processor Utilization

+------+-----+---------+---------+----------+

| Cpu | Cpu utilization during past |

| Type | Id | 1 Sec 4 Secs 64 Secs |

+------+-----+---------+---------+----------+

SP | 1 | 0% | 0% | 0% |

FP | 2 | 0% | 0% | 0% |

FP | 3 | 0% | 0% | 0% |

Datapath CPU Allocation Summary
Slow Path (SP) : 1, Slow Path Gateway (SPGW) : 0

Fast Path (FP) : 2, Fast Path Gateway (FPGW) : 0

DPI : 0, Crypto (CRYP) : 0

(ArubaMM) [mynode] #
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Chapter 5
Post-Installation Procedures

Once the installation is complete, follow these post-installation procedures to complete the deployment.

Configuring the Initial Setup
Follow the steps below to configure initial setup:

1. Click Power on the virtual machine.

2. Enter values for the following first boot parameters in the console:

l System name

l Switch role

l IP type to terminate IPsec tunnel

l Master switch IP address or FQDN

l Is this a VPN concentrator for managed device to reach Master switch

l This device connects to Master switch via VPN concentrator

l Master switch Authentication method

l IPsec Pre-shared Key

l Uplink Vlan ID

l Uplink port

l Uplink port mode

l Uplink Vlan IP assignment method

l Uplink Vlan Static IP address

l Uplink Vlan Static IP netmask

l IP default gateway

l DNS IP address

l IPV6 address on vlan

l Uplink Vlan Static IPv6 address

l Uplink Vlan interface IPV6 prefix length

l IPv6 default gateway

l Country code

l Time Zone

l Time in UTC

l Date

l Password for admin login

l Re-type password for admin login

The choices you entered in the first boot dialog are displayed.

Enter a static IP as the management IP in VLAN as part of the Mobility Master/VMC setup. This should be a routable IP
in an accessible subnet that the user can use to access the Mobility Master/VMC via CLI (SSH) or Web GUI (HTTP)
 after VM setup is complete.

Enter <Ctrl P> to make changes to the first boot parameters.
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3. Enter Yes to accept the changes. The Mobility Master/VMC reboots and displays the log in prompt.

4. Log in with user name as admin and the use password set in Step 2.

5. Execute the enable command.

6. Power on the Mobility Master/VMC and execute the following command to enable the serial console.

Serial console redirect requires the vSphere Enterprise Plus license. When you enable serial console redirect, the
vSphere console host window will be blank.

(host) #serial console redirect enable

Execute the following command to see the status of the serial console.
(host) #show serial console redirect

Serial Console Redirect : Enabled

Execute the following commands to disable and view the status of the serial console.
(host) #serial console redirect disable

(host) #show serial console redirect

Serial Console Redirect : Disabled

Reboot the Mobility Master/VMC to access the serial console after enabling the serial console redirect.

To access the serial console telnet the IP address of the serial console followed by the serial port configured. For
example: telnet 10.16.12.27 6001.

Management Interface
The ArubaMobility Master/VMC are VM instances and access to the console is dependent on the deployment
environment. If access through the serial port is denied you can alternatively access the console through the
Management Interface. After an IP is assigned, the management interface can be accessed from anywhere in
the network. To implement this change a separate routing table is assigned with its own default gateway for
managing the IP that is introduced. This ensures the management traffic is routed to the right interface.

The initial implementation of this feature covers IPv4, IPv6, and manual configuration of a static IP for
management interface from the console.

This feature cannot be configured using the WebUI.

Execute the following commands to configure an IP on the management interface:

IPv4:
(host) [mynode] #configure terminal

Enter Configuration commands, one per line. End with CNTL/Z

(host) [mynode] (config) #interface mgmt

(host) [mynode] (config-submode)#ip address 10.16.9.203 255.255.255.0

IPv6:
(host) [mynode] (config) #interface mgmt

(host) [mynode] (config-submode)#ipv6 address 2014::184/64

Execute the following commands to configure a default gateway for the management interface traffic and to
segregate the management traffic from the normal data traffic on datapath ports:

IPv4
(host) [mynode] (config) #ip default-gateway mgmt 10.16.9.2

IPv6:



(host) [mynode] (config) #ipv6 default-gateway mgmt 2014::1
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Chapter 6
Troubleshooting

ARP Issues

Scenario
ARP issue occurs when Promiscuous Mode is not enabled and all VLANs are disallowed on vSwitch.

Instructions
Enable Promiscuous Mode and allow all VLANs on vSwitch.

To enable Promiscuous Mode, perform the following steps:

1. Log in to vSphere ESXi Host.

2. Switch to Configuration tab.

3. Select Networking underHardware section.

4. Click Properties for a configured vSwitch.

5. Click Edit under Ports tab of vSwitch Properties window.

6. Switch to Security tab in vSwitch Properties window.

7. Select Accept from the Promiscuous Mode drop-down list.

Enable Promiscuous Mode on all ports attached to the VM.

8. Click OK.

To allow all VLANs on vSwitch, perform the following steps:

1. Log in to the vSphere ESXi Host.

2. Click theConfiguration tab.

3. Select Networking underHardware section.

4. Click Properties for a configured vSwitch.

5. Select a configured VM network under Ports tab of vSwitch Properties window.

6. Click Edit under Ports tab of vSwitch Properties window.

7. Select All (4095) from the drop-down list against VLAN ID (Optional).

8. Click OK.

Characters Repeating In Remote Console
The user notices unintended keystrokes when typing into a remote console. To resolve this issue, refer to the
following KB article:

http://kb.vmware.com/selfservice/microsites/search.do?language=en_US&cmd=displayKC&externalId=196

Networks Cards Not Detected
When a new network card is added to the ESXi/ESX host the following symptoms might be displayed:

l The new network card is not recognized by the system.

http://kb.vmware.com/selfservice/microsites/search.do?language=en_US&cmd=displayKC&externalId=196
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l The new network card is not listed when you run the command esxcfg-nics -l.

To resolve this issue, refer to the following KB article:

http://kb.vmware.com/selfservice/microsites/search.do?language=en_
US&cmd=displayKC&externalId=1034782

HP Proliant DL580 Running ESXi 5.5 Is Not Powered On Due To
Memory Leaks
HP Proliant DL580 running ESXi 5.5 will not be powered on due to memory leaks. To resolve this issue, refer to
the following KB article:

http://kb.vmware.com/selfservice/microsites/search.do?language=en_%20US&cmd=displayKC&externalId=2
085618

Network Interfaces Are Not In The Correct Order
Adding a fifth network adapter that uses vmxnet3 devices changes the PCI bus IDs and also the order of
network interfaces. To resolve this issue, refer to the following KB article:

https://communities.vmware.com/thread/443600

Connectivity Issues Observed When Using Multiple vSwitches
Connectivity issues observed when multiple vSwitches in a VM network. To resolve this issue, refer to the
following KB article:

https://communities.vmware.com/thread/460582

http://kb.vmware.com/selfservice/microsites/search.do?language=en_US&cmd=displayKC&externalId=1034782
http://kb.vmware.com/selfservice/microsites/search.do?language=en_US&cmd=displayKC&externalId=1034782
http://kb.vmware.com/selfservice/microsites/search.do?language=en_%20US&cmd=displayKC&externalId=2085618
http://kb.vmware.com/selfservice/microsites/search.do?language=en_%20US&cmd=displayKC&externalId=2085618
https://communities.vmware.com/thread/443600
https://communities.vmware.com/thread/460582
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Chapter 7
Appendix

This chapter details additional information required in the current version of the Mobility Master. Click the
following links for more information:

l Increasing the Flash Size on a vSphere Hypervisor on page 43

l Increasing the Flash Size on a KVM Hypervisor on page 46

l Backing up and Restoring Critical Data on page 48

l Datapath Debug Commands on page 51

l Implementing Management Interface on page 50

l Upgrading a Controller on page 54

Increasing the Flash Size on a vSphere Hypervisor
ArubaOS enables you to increase the size of your flash to ensure that the flash is hosted on a separate disk. By
doing this you can move to a hard disk with higher storage capacity for flash with minimal impact. Follow the
steps below to increase the size of the flash on the Mobility Master.

1. Power down the VM.

2. Right click the VM in the vSphere client and click Edit Settings.

3. Click Add in theVirtual Machine Properties window.

Figure 31 Virtual Machine Properties

4. Click Hard Disk in theAdd Hardware window and click Next.
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Figure 32 Selecting the Device Type

5. Select Create a new virtual disk and click Next.
6. Enter a value of the desired disk size and select Thick Provision Lazy Zeroed. Click Next.

Figure 33 Create Disk

7. Click Next in theAdvanced Options window and click Finish.



Figure 34 New Hard Disk

8. Power on the VM and ArubaOS will migrate data from the old hard disk to the new one.

Figure 35 Migrating Data

9. Confirm if the newly added Hard disk 3 is used by ArubaOS. TheHard disk 3 will be listed as /dev/sdc1
and if old hard disk is in use, it will be listed as /dev/sdb1. If the OVF file only contains a single hard disk it
be listed as /dev/sda3.

10.If the newHard disk 3 is working as expected, the older hard disk can be removed from the VM and
deleted from disk of the vSphere server.
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Figure 36 Removing a Hard Disk

ArubaOS supports only 3 disks and the size of the new disk that is added should be more than the current disk size.

Increasing the Flash Size on a KVM Hypervisor
ArubaOS enables you to increase the size of your flash to ensure that the flash is hosted on a separate disk. By
doing this you can move to a hard disk with higher storage capacity for flash with minimal impact. Follow the
steps below to increase the size of the flash on the Mobility Master.

1. To protect the data on the controller, take a flashback up of ArubaOS using scp/ftp/tftp.
(ArubaMM) [mynode] #show storage

Filesystem Size Used Available Use% Mounted on

none 3.0G 5.6M 3.0G 0% /tmp

/dev/vdb1 7.7G 452.7M 6.9G 6% /flash

/dev/vda5 1.4G 380.3M 1022.7M 27% /mnt/disk1

/dev/vda6 1.4G 380.3M 1022.7M 27% /mnt/disk2

(ArubaMM) [mynode] #backup flash

Please wait while we take the flash backup.......

File flashbackup.tar.gz created successfully on flash.

Please copy it out of the controller and delete it when done.

(ArubaMM) [mynode] # copy flash: flashbackup.tar.gz scp: 10.16.9.107 tester

flashbackup.tar.gz

2. Access the virt-manager and right click on the VM. Select Shut Down.

3. Click Shut Down for a graceful shutdown of the VM.



Figure 37 Graceful Shutdown

4. Add a new VirtIO Disk according to your requirement. For more information refer to the sizing table in
ArubaOS VM Requirements on page 10.

5. Double click the VM and click Show virtual hardware details. Click on Add Hardware.

6. In theAdd New Virtual Hardware window click Storage. Enter a desired value for theCreate a disk
image on the computer hard drive option and click Finish. A new disk is added.

Figure 38 Adding New Virtual Hardware

7. Power on the VM. The following message is displayed when ArubaOS boots up.

Aruba Mobility Master and VMC | Installation Guide Appendix |  47



48 | Appendix Aruba Mobility Master and VMC  | Installation Guide

Aruba Networks

ArubaOS Version 8.0.1.0 (build 57204 / label #57204)

Built by p4build@lemnos on 2016-11-06 at 20:26:23 PST (gcc version 4.7.2)

(c) Copyright 2016 Hewlett Packard Enterprise Development LP.

[10:18:22]:Starting device manager [ OK ]

Formatting new flash [ OK ]

Forcing filesystem check on new flash [ OK ]

Mounting new flash [ OK ]

Copying files to new flash [ OK ]

8. Once the system boots up, the new disk will show up as vdc and not vdb. The flash will contain the old data.
(ArubaMM) [mynode] #show storage

Filesystem Size Used Available Use% Mounted on

none 3.0G 7.5M 3.0G 0% /tmp

/dev/vdc1 15.6G 477.7M 14.4G 3% /flash

/dev/vda5 1.4G 380.3M 1022.7M 27% /mnt/disk1

/dev/vda6 1.4G 380.3M 1022.7M 27% /mnt/disk2

(ArubaMM) [mynode] #

9. Power off the VM and select VirtIO Disk2. Click Remove and reboot the controller.
10.Click Yes in theAre you sure you want to remove this device window.

11.The following information is displayed after rebbot and you will be able to use the new disk.
(ArubaMM) [mynode] #show storage

Filesystem Size Used Available Use% Mounted on

none 3.0G 7.6M 3.0G 0% /tmp

/dev/vdb1 15.6G 477.8M 14.4G 3% /flash

/dev/vda5 1.4G 380.3M 1022.7M 27% /mnt/disk1

/dev/vda6 1.4G 380.3M 1022.7M 27% /mnt/disk2

(ArubaMM) [mynode] #

ArubaOS supports only 3 disks and the size of the new disk that is added should be more than the current disk size.

Backing up and Restoring Critical Data
It is important to frequently back up all critical configuration data and files on the compact flash file system to
an external server or mass storage device. Ensure the following files are backed up regularly:

l Configuration data

l WMS database

l Local user database

l Licensing database

l Floor plan JPEGs

l Custom captive portal pages

l x.509 certificates

l Controller Logs

Back Up and Restore Compact Flash in the WebUI
The WebUI provides the easiest way to back up and restore the entire compact flash file system. The following
steps describe how to back up and restore the compact flash file system using the WebUI on the Mobility



Master:

1. Click on theConfiguration tab.

2. Click Pending Configuration and then Deploy Changes. Pending Changes is visible only when there
changes to be saved, if this option is not visible skip this step.

3. Navigate to theDiagnostics > Technical Support > Backup Flash page.

4. Click Create Backup to back up the contents of the compact flash file system to the flashbackup.tar.gz file.

5. Click Copy Backup to copy the file to an external server.

You can later copy the backup file from the external server to the compact flash file system using the file
utility in theDiagnostics > Technical Support > Copy Files page.

6. To restore the backup file to the compact flash file system, navigate to theDiagnostics > Technical
Support > Restore Flash page. Click Restore.

Back Up and Restore Compact Flash in the CLI
The following steps describe the backup and restore procedure for the entire compact flash file system using
the controller’s command line:

1. Enter config mode in the CLI on the controller, and enter the following command:
(host) [mynode] (config) #write memory

2. Use the backup command to back up the contents of the compact flash file system to the
flashbackup.tar.gz file.
(host) [mynode] (config)# backup flash

Please wait while we tar relevant files from flash...

Please wait while we compress the tar file...

Checking for free space on flash...

Copying file to flash...

File flashbackup.tar.gz created successfully on flash.

3. Use the copy command to transfer the backup flash file to an external server or storage device:
(host) [mynode] (config) copy flash: flashbackup.tar.gz ftp: <ftphost> <ftpusername>

<ftpuserpassword> <remote directory>

(host) [mynode] (config) copy flash: flashbackup.tar.gz usb: partition <partition-number>

You can later transfer the backup flash file from the external server or storage device to the compact flash
file system with the copy command:
(host) [mynode] (config) # copy tftp: <tftphost> <filename> flash: flashbackup.tar.gz

(host) [mynode] (config) # copy usb: partition <partition-number> <filename> flash:

flashbackup.tar.gz

4. Use the restore command to untar and extract the flashbackup.tar.gz file to the compact flash file system:
(host) [mynode] (config) # restore flash

Back Up and Restore Configuration in the CLI
The following steps describe the backup and restore procedure for the config file system using the controller’s
command line:

1. Enter config mode in the CLI on the controller, and execute the following command:
(host) [mynode] (config) #write memory

2. Use the backup command to back up the contents of the compact flash file system to the
configbackup.tar.gz file.
(host) [mynode] (config) # backup flash

Please wait while we tar relevant files from flash...

Please wait while we compress the tar file...

Checking for free space on flash...

Copying file to flash...

File configbackup.tar.gz created successfully on flash.
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3. Use the copy command to transfer the backup flash file to an external server or storage device:
(host) [mynode] (config) copy flash: configbackup.tar.gz ftp: <ftphost> <ftpusername>

<ftpuserpassword> <remote directory>

(host) [mynode] (config) copy flash: configbackup.tar.gz usb: partition <partition-number>

You can later transfer the backup flash file from the external server or storage device to the compact flash
file system with the copy command:
(host) # copy tftp: <tftphost> <filename> flash: configbackup.tar.gz

(host) # copy usb: partition <partition-number> <filename> flash: configbackup.tar.gz

4. Use the restore command to untar and extract the configbackup.tar.gz file to restore the configuration:
(host) [mynode] (config) # restore config

Please wait while we restore the config backup........

Config restored successfully.

Please reload (reboot) the controller for the new config to take effect.

Snapshot
A VMware snapshot is a copy of the virtual machine's disk file (VMDK) at a given point in time. Snapshots
provide a change log for the virtual disk and are used to restore a VM to a particular point in time when a failure
or system error occurs.

A snapshot preserves the state and data of a virtual machine at a specific point in time. A virtual machine
provides several operations for creating and managing snapshots and snapshot chains. These operations let
you create snapshots, revert to any snapshot in the chain, and remove snapshots. For additional information
about snapshots refer to the VMware kb article 1015180.

Implementing Management Interface
This sections discusses implementation of the management interface on the Mobility Master. It includes the
following:

l Assigning the IP address to the management interface from the CLI

l Ensuring management bound traffic uses the correct interfaces and a default gateway specific to the
management interface

l Protecting the management interface against unwanted traffic and DOS attacks

Once the IP is assigned (manual or dynamic) we should be able to reach the management interface from
anywhere in the network. This requires that we have a default gateway for the management interface. But this
default gateway should not be used for the data routing table of the controller. So the inherent problem is that
we need to have two default gateways one for the management interface and the other for the data traffic and
the management traffic should be via the management interface only. This is solved by the use of the iproute2
utility and having a separate routing table with its own default gateway for the management IP. With this we
can ensure that the management traffic does not leak onto unwanted interfaces.

The management interface is mapped to eth0 and is a Linux interface. It is not a part of SOS and does not have
access to the SOS firewall to protect itself. Since the management interface is susceptible to attacks it is
imperative that we should firewall this interface. For this we use the iptables firewall present in Linux. We allow
only ssh (22), telnet(2323) ,tftp(69) and HTTPS(443,4343) traffic on the mgmt. interface and also rate limit
traffic to protect controller from unwanted traffic flood over the network. Initially phase of this feature is
implemented for manually configuring a static IP for management interface from the console. It covers both
IPv4 and IPv6 implementation. Most of the functional behavior and implementation are same for IPv4 and
IPv6. This feature can be extended for obtaining IP dynamically from DHCP server in the network in future.

https://kb.vmware.com/selfservice/microsites/search.do?language=en_US&cmd=displayKC&externalId=1015180


Datapath Debug Commands
Listed below are the commands to view the system statistics of your controller:

l Execute the show datapath frame [counters] command to view statistics of the data traffic processed.
This command displays the frame statistics that are received and transmitted from the datapath of the
controller. Allocated frames indicate buffers allocated at any given point of time. A constant increment in
the buffer indicates a buffer leak.

The following example displays statistics of data traffic processed.
(host) #show datapath frame counters

+----+------+-----------------------------------------------------+

|SUM/| | | |

|CPU | Addr | Description Value |

+----+------+-----------------------------------------------------+

| | [00] | Allocated Frames 3155 |

| | [03] | Unknown Unicast 127 |

| | [04] | IPv6 Unknown Unicast 5 |

+----+------+-----------------------------------------------------+

| | | |

| G | [00] | BPDUs Received 28 |

+----+------+-----------------------------------------------------+

l Execute the show port stats command to view the traffic received/transmitted through gigabit ports
using the datapath.

The following example displays the port statistics.
(host) #show port stats

Port Statistics

---- --------- ---------- ------- -------- --------------- ---------------- --------- -----

---

Port PacketsIn PacketsOut BytesIn BytesOut InputErrorBytes OutputErrorBytes CRCErrors

RxNoMbuf

---- --------- ---------- ------- -------- --------------- ---------------- --------- -----

---

GE 0/0/0 6179766 46516 1192249262 3446810 0 0 0 0

GE 0/0/1 179 166996 14782 5019706 0 0 0 0

GE 0/0/2 0 0 0 0 0 0 0 0

l Execute the show datapath heartbeat stats command to monitor the health of the systems. Heartbeats
are sent from the control plane to the datapath every second. The packets pass through the datapath CPUs
and return to the control plane in one second. If the load on the system increases or there is a CPU lock
there is a possibility of the heartbeat being missed. If this recurs 30 times consecutively the controller
reboots. The heartbeat probe introduced in this release, sends out a probe when two consecutive
heartbeats are missed and also measures the actual time taken for the packets to pass through the
datapath CPUs and return to the control plane.

The following example displays the heartbeat statistics.
(host) #show datapath heartbeat stats

Sibyte HeartBeat Stats:

Total HB sent: 42686

Total HB send errors: 0

Current HB send errors: 0 (max:30)

HB send errors high water-mark: 0
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Sibyte Probe Stats:

Total probes sent: 0

Last probe sent @ 0:00:00.000

Last probe rcvd @ 0:00:00.000

l Execute the show datapath dpdk [mempool-stats | ring-stats] command to view the DPDK mempool
and ring statistics. Since the size of the mempool and ring may vary based on the system template this
command identifies the size of the structures used.

The following example displays DPDK mempool and ring statistics.
(host) #show datapath dpdk mempool-stats

DPDK Memory Pool Statistics Table

--------- --------- ----- ------- ---- ------- ------- ----- ----------- ------------ ------------ --------- --------- ----------
mPoolName mPoolAddr Flags phyAddr Size hdrSize eltSize tSize priDataSize success_bulk

success_objs fail_bulk fail_objs cPoolCount

--------- --------- ----- ------- ---- ------- ------- ----- ----------- ------------ -----

------- --------- --------- ----------

log_history 0x2aaaaa802080 0 0x0xa9002080 512 64 2048 0 0 0 0 0 0 479

mbuf_pool 0x2aaa36200000 0 0x0xa9400000 65536 64 4032 0 0 0 0 0 0 62935

msg 0x7fecd6700080 0 0x0x24700080 1024 64 40 24 0 0 0 0 0 1024

(host) #show datapath dpdk ring-stats

DPDK Ring Statistics Table

---- ---- ---------- -----

Flags: Flag - set for single producer or consumer

Used - number of entries in a ring

Freed - number of free entries in a ring

QThreshold - Enqueque Threshold

nQSuccessBulk - Successful enqueues number

nQSuccessObjs - Objects successfully enqueued

nQFailBulk - Failed enqueues number

nQFailObjs - Objects that failed to be enqueued

dQSuccessBulk - Sucessful dequeues number

dQSuccessObjs - Objects successfully dequeued

dQFailBulk - Failed dequeues number

dQFailObjs - Objects that failed to be dequeued

RingName RingAddr Flag Used Freed QThreshold nQSuccessBulk nQSuccessObjs nQFailBulk

nQFailObjs dQSuccessBulk dQSuccessObjs dQFailBulk dQFailObjs

-------- -------- ---- ----- ----- ---------- ------------- ------------- ---------- ------

---- ------------- ------------- ---------- ----------

MP_log_history 0x2aaaaa800000 0 479 544 0 0 0 0 0 0 0 0 0

MP_mbuf_pool 0x7fecd6600000 0 62908 68163 0 0 0 0 0 0 0 0 0

core-0-low 0x2aaaaa98a5c0 2 0 1023 0 0 0 0 0 0 0 0 0

core-0-high 0x2aaaaa98c640 2 0 1023 0 0 0 0 0 0 0 0 0

core-1-low 0x2aaaaa98e6c0 2 0 1023 0 0 0 0 0 0 0 0 0

core-1-high 0x2aaaaa990740 2 0 1023 0 0 0 0 0 0 0 0 0

core-2-low 0x2aaaaa9927c0 2 0 1023 0 0 0 0 0 0 0 0 0

core-2-high 0x2aaaaa994840 2 0 1023 0 0 0 0 0 0 0 0 0

MP_msg 0x2aaaaa9968c0 0 1024 1023 0 0 0 0 0 0 0 0 0



l Execute the show datapath utilization command to view the CPU utilization of all the datapath CPUs
(SP/FP).

The following example displays datapath CPU utilization statistics.

If the CPU speed is more than 2.1 GHz, data displayed under the 64 Secs option is invalid, but valid only for 1 Sec and
4 Sec options. Counter inconsistency is only for CPUs with speed more than 2.1 GHz.

(host) #show datapath utilization

Datapath Network Processor Utilization

------+---------+---------+----------+

| Cpu utilization during past |

Cpu | 1 Sec 4 Secs 64 Secs |

------+---------+---------+----------+

1 | 0% | 0% | 0% |

2 | 0% | 0% | 0% |

l Execute the show cpuload [current] command to view the controller's CPU load for application and
system processes. Use the current option to check the output of the top two UNIX commands.

The following example shows that the majority of the controller’s CPU resources are not being used by
either the application (user) or system processes.
(host) #show cpuload

user 6.9%, system 7.7%, idle 85.4%

The following example displays the summary of system (CPU) load. When the current option is used, it
displays detailed information of the CPU load for each process.
(host) #show cpuload [current]

top2 - 05:09:29 up 2 days, 9 min, 0 users, load average: 0.00, 0.01, 0.05

Tasks: 132 total, 2 running, 130 sleeping, 0 stopped, 0 zombie

Cpu(s): 2.5%us, 1.5%sy, 0.0%ni, 96.0%id, 0.0%wa, 0.0%hi, 0.0%si, 0.0%st

Mem: 7915932k total, 2817304k used, 5098628k free, 2744k buffers

Swap: 0k total, 0k used, 0k free, 193244k cached

PID USER PR NI VIRT RES SHR S %CPU %MEM TIME+ COMMAND

3462 root 20 0 2134m 16m 7772 S 26 0.2 744:48.18 sos.shumway.elf

3654 root 20 0 56112 5856 4732 S 4 0.1 40:48.87 gsmmgr

3503 root 20 0 0 0 0 R 2 0.0 63:24.05 kni_single

1 root 20 0 8340 676 572 S 0 0.0 0:00.92 init

2 root 20 0 0 0 0 S 0 0.0 0:00.00 kthreadd

3 root 20 0 0 0 0 S 0 0.0 0:00.22 ksoftirqd/0

5 root 20 0 0 0 0 S 0 0.0 0:02.02 kworker/u:0

6 root RT 0 0 0 0 S 0 0.0 0:00.00 migration/0

7 root RT 0 0 0 0 S 0 0.0 0:00.00 migration/1

8 root 20 0 0 0 0 S 0 0.0 0:01.94 kworker/1:0

9 root 20 0 0 0 0 S 0 0.0 0:07.79 ksoftirqd/1

10 root 20 0 0 0 0 S 0 0.0 0:01.26 kworker/0:1

11 root RT 0 0 0 0 S 0 0.0 0:00.00 migration/2

12 root 20 0 0 0 0 S 0 0.0 0:01.08 kworker/2:0

13 root 20 0 0 0 0 S 0 0.0 0:05.80 ksoftirqd/2

14 root 0 -20 0 0 0 S 0 0.0 0:00.00 cpuset

15 root 0 -20 0 0 0 S 0 0.0 0:00.00 khelper
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16 root 0 -20 0 0 0 S 0 0.0 0:00.00 netns

...

Upgrading a Controller
Follow the steps below to upgrade the controller. You can upgrade the OS on the controller either through
WebUI or through the CLI. The following methods can be used to upgrade the OS on the controller:

l TFTP

l FTP

l SCP

l Local File (This option is available while upgrading through WebUI)

Be sure to back up the controllers as described in Backing up and Restoring Critical Data.

In the WebUI:

1. In the Mobility Master node hierarchy, navigate to Configuration > Upgrade > Software Management.
2. Choose the upgrade method.

3. If you are using TFTP, FTP, or SCP for upgrade enter the server IP address.

4. Enter the image file name.

5. Choose the partition to upgrade.

6. Select Yes to Reboot Controller After Upgrade.

7. Select Yes to Save Current Configuration Before Reboot.
8. Click Upgrade.

In the CLI:

Execute the following commands on the CLI to upgrade the OS:

For TFTP: (host) [mynode] (config)# copy tftp: <TFTP server IP address> <image file name>

system: partition <0 or 1>

For FTP: (host) [mynode] (config)# copy ftp: <FTP server IP address> <username> <image file

name> system: partition <0 or 1>

For SCP: (host) [mynode] (config)# copy scp: <SCP host IP address> <username> <image file name>

system: partition <0 or 1>

Once the image is uploaded in the flash, save the configuration and reload the controller.

If the following error message is displayed, follow the steps above to reload the OS on both partitions.
(host) [mynode] (config)# show image version

Ancillary image stored on flash is not for this release

*********************************************************************

* WARNING: An additional image upgrade is required to complete the *

* installation of the AP and WebUI files. Please upgrade the boot  *

* partition again and reload the controller.                       *

*********************************************************************
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